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The Editor’s menus are far more complex than the Organizer’s menus. All three 
of the Editor’s modes—Expert, Quick Fix, and Guided Edit—have the same 
menus, although some choices are grayed out when you’re in Quick Fix or 

Guided Edit mode. So if you need a menu item that’s not available in Quick Fix or 
Guided Edit, just switch back to Expert mode to use it.

Several of the menus in Elements are dynamic, meaning they change quite a bit to 
reflect the choices currently applicable to your image. Because of that, the choices 
you see in this appendix represent only what you may see depending on the situa-
tion. The Layer menu, for instance, offers you very different options depending on 
the current state of your image and which layer is active.

 NOTE  If you have Adobe Premiere Elements installed, then you’ll see some extra menu options not included 
in this basic list. 

Whether you have a Mac or a PC, your menu choices are nearly identical, except for the leftmost menu, as 
explained next.

Also, all the page numbers mentioned in this appendix point to pages in Photoshop Elements 13: The Missing 
Manual, not this appendix.

System Menu (Windows only)
At the upper-left corner of the Elements window, the teal square with a white 
diamond inside it is actually a button. Click it to get a pop-out menu for closing, 

  The Editor, Menu 
by Menu
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PHOTOSHOP 
ELEMENTS 

EDITOR MENU 
(MAC ONLY)

moving, maximizing, and minimizing the Editor window, as well as for restoring it 
to its original size.

Photoshop Elements Editor Menu 
(Mac only)

These menu choices provide info about Elements, let you adjust some of its settings, 
and control the program’s visibility.

 NOTE  The leftmost item in your menu bar, the Apple menu, is system-wide and not part of Elements.

ABOUT PHOTOSHOP ELEMENTS
Choose this menu item to see a window with info about the version of Elements you 
have. It includes a long list of patents and credits—a testimony to the complexity of 
the engineering that goes into Elements.

ABOUT PLUG-IN
Select this option for a long pop-out menu displaying all the plug-ins in your copy 
of Elements. Choose a plug-in from the list to see its version and date info.

LEGAL NOTICES
This item displays a list of the various patents for Elements, as well as trademark 
information for some of the components used in the program.

PREFERENCES
This menu item gives you access to the many Elements settings you can customize. 
You’ll find the following preference windows available from this menu:

•	 General (or press z-K)

•	 Saving Files

•	 Performance (where you set the number of history states and assign scratch 
disks—see page 598)

•	 Display & Cursors

•	 Transparency

•	 Units & Rulers

•	 Guides & Grid

•	 Plug-Ins

•	 Adobe Partner Services (the online services like Shutterfly)
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FILE MENU
•	 Application Updates (where you can choose whether to have Elements update 

itself automatically or just let you know when an update is available)

•	 Type

•	 Organize and Share (this is a link to the Organizer’s preferences)

SERVICES
This is where you can access any of the little OS X utility programs (a.k.a. services) 
that are compatible with Elements. As of this writing, there aren’t any services that 
are compatible with Elements, so this item is always grayed out.

HIDE PHOTOSHOP ELEMENTS
If you don’t want Elements to be visible, choose this item or press Control-z-H.

HIDE OTHERS
If you want Elements to be your only visible program, choose this option or press 
Option-z-H.

SHOW ALL
Use this to bring all your hidden programs back into view.

QUIT PHOTOSHOP ELEMENTS
You can shut Elements down by choosing this menu item or pressing z-Q.

File Menu
The commands in this menu let you create, import, open, save, and print files.

NEW
Choose this item if you want to start a new file in Elements. Your options are:

•	 Blank File (or press Ctrl+N/z-N).

•	 Image from Clipboard. This automatically pastes into a new file anything 
you’ve copied.

OPEN
Choose this item or press Ctrl+O/z-O to open an existing file.

OPEN IN CAMERA RAW
If you want to use the Raw Converter to edit a file format other than a raw file, like 
a JPEG or TIFF, choose this menu item to send the file to the Converter. Page 289 
has more information about why you’d want to do that. 
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FILE MENU
OPEN RECENTLY EDITED FILE

Here’s where you’ll find a pop-out list of the most recent files you’ve had open in 
Elements.

DUPLICATE
When you need to make a copy of your photo, choose this option. Elements names 
the copy the same thing as the original with “copy” tacked onto the end, though 
you can change the copy’s name in the dialog box that appears.

CLOSE
To close the active image window, choose this menu item or press Ctrl+W/z-W.

CLOSE ALL
To close all your open image windows, choose this option or press Alt+Ctrl+W/
Option-z-W.

SAVE
To save your work, select this option or press Ctrl+S/z-S.

SAVE AS
To save your image with a different filename or in a different format, choose this 
command or press Shift+Ctrl+S/Shift-z-S.

SAVE FOR WEB
To save an image so that it’s optimized for posting on a web page or sending by 
email, choose this menu item or press Alt+Shift+Ctrl+S/Option-Shift-z-S. Page 556 
has info about the Save For Web dialog box.

FILE INFO
Choose this menu item to bring up the File Info window, which includes all sorts of 
information about your image, like its creation date, file format, and so on.

PLACE
Use this command to place a PDF, Adobe Illustrator, or EPS file into an image as a new 
layer. If the artwork is larger than the image you place it in, Elements automatically 
makes it small enough to fit. Anything that you put into a file with this command 
(including objects from images in regular formats like TIFF or JPEG) becomes a 
Smart Object (page 517).

ORGANIZE OPEN FILES
Choose this menu option to add the files you have open in the Editor to the Organizer.

PROCESS MULTIPLE FILES
This is where you batch-process files to rename them, change their format, add 
copyright info, and so on. See page 301 to learn everything that Elements lets you 
do to groups of files.
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FILE MENU
IMPORT

This is where you can connect to external devices like scanners. (They’ll show up 
in this menu if you install their drivers, and if those drivers include a compatible 
plug-in. You also need to install the TWAIN plugin for the Mac version of Elements 
and the 32-bit Windows version of Elements as explained on page 38.) Before you 
install anything, the Import command is grayed out on a Mac. In Windows, you see 
the WIA Support option; WIA is the built-in support for scanners that’s part of the 
Windows operating system.

EXPORT
This command is always grayed out. That’s normal. Adobe left it in for the benefit 
of any third-party plug-ins that may need it—but you don’t need it in Elements to 
use the program’s standard tools and commands. (If you need to export files from 
the Organizer, see page 530.)

AUTOMATION TOOLS
You only have one choice here unless you install a third-party plug-in that makes use 
of this menu. Out of the box, your only choice is Fit Image, which lets you choose 
a pixel dimension for one side of your photo and resizes it to fit within that space.

PRINT
Choose this command and you get the Print window, which is discussed in detail in 
Chapter 16. Keyboard shortcut: Ctrl+P/z-P.

ORDER PRINTS
This is your portal for connecting to Shutterfly to order prints, calendars, or photo 
books. (See page 530 to learn how to order prints online.) Choose this item and 
Elements switches you over to the Organizer, and then connects you from there.

EXPORT CREATIONS
When you’ve made a Create project (see Chapter 15), you can use this menu item to 
save your creation as separate JPEG, TIFF, or PDF files for each page. This is espe-
cially handy if you don’t use the Organizer, or if you want to use one of the templates 
meant for the online services (a Shutterfly photo book, for instance) without actually 
ordering your project there.

CONTACT SHEET II (MAC ONLY)
To make a contact sheet showing thumbnails of many photos (see page 549), choose 
this menu item or press Option-z-P.

PICTURE PACKAGE (MAC ONLY)
Choose this command to print several photos—or multiple copies of one photo—in 
different sizes on one page (see page 551).
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EDIT MENU
EXIT (WINDOWS ONLY)

You can close the Editor by selecting this item or by pressing Ctrl+Q. The Organizer 
doesn’t quit along with the Editor, though, so if the Organizer is also running, you 
have to exit it separately.

Edit Menu
The choices listed here let you make changes to your files. In Windows, this is also 
where you access Elements’ preferences to change their settings.

UNDO
To back out of your last action, select this item or press Ctrl+Z/z-Z. You can keep 
applying this command to undo as many steps as you’ve set in the History panel’s 
preferences (Edit→Preferences→Performance→History States/Photoshop Elements 
Editor→Preferences→Performance→History States).

REDO
If you undo something and then change your mind, redo it by choosing this menu 
item or pressing Ctrl+Y/z-Y.

REVERT
Choose this command to return your image to the state it was in the last time you 
saved it.

CUT
To remove something from your image and store it on the Clipboard (so you can 
paste it into another file), choose this menu item or press Ctrl+X/z-X.

COPY
To copy something to the Clipboard, highlight it and then select this menu item 
or press Ctrl+C/z-C. This command copies only the active layer in a layered file, 
however. To copy all the layers in your selected area, use Copy Merged (explained 
next) instead.

COPY MERGED
To make a single, combined copy of all the layers in the selected area to the Clip-
board, choose this menu option or press Shift+Ctrl+C/Shift-z-C. To copy just the 
active layer, use Copy instead.

PASTE
Choose this command or press Ctrl+V/z-C to add whatever you’ve cut or copied 
to an image.
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EDIT MENU
PASTE INTO SELECTION

Use this special command to paste something within the confines of an existing 
selection. See page 151 for more on how this command works. Keyboard shortcut: 
Shift+Ctrl+V/Shift-z-V.

DELETE
This command removes what you’ve selected without copying it to the Clipboard—it’s 
just gone. You can press Backspace to do the same thing.

FILL LAYER, FILL SELECTION
Choose this menu item to fill your active layer with a color or pattern. When you have 
an active selection in your image, this menu item changes to read “Fill Selection.” 
You can also choose a blend mode and opacity for your fill.

STROKE (OUTLINE) SELECTION
This command puts a colored border around the edges of a selection.

DEFINE BRUSH, DEFINE BRUSH FROM SELECTION
To create a custom brush from your photo or from an area of your photo, choose 
this command. The process is explained in detail on page 405.

DEFINE PATTERN, DEFINE PATTERN FROM SELECTION
This command creates a pattern from your image or selection. See page 324 for 
more about applying patterns.

CLEAR
Use this command to permanently remove information from the History panel, the 
Clipboard, or both (choose All). If you have a corrupt image in the Clipboard (or one 
that’s too large), it may cause Elements to slow way down or quit on you. Once in 
a while, the Clipboard may get stuck, too—meaning that when you try to copy and 
paste an item, you just get whatever you copied previously. This command fixes 
such problems.

COLOR SETTINGS
Here’s where you choose a color space for Elements (page 240). Keyboard shortcut: 
Shift+Ctrl+K/Shift-z-K.

PRESET MANAGER
This is where you access the window that helps you manage your brushes, swatches, 
gradients, and patterns. See page 587 for more on how the Preset Manager works.

START DICTATION (MAC ONLY)
There really isn’t much use for this in Elements, but if you want to dictate the contents 
of a text block, use this menu command or press the fn key twice.
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PREFERENCES (WINDOWS ONLY)

This menu item gives you access to the many Elements settings you can customize. 
(In OS X, you get to Elements’ preferences through the Photoshop Elements Editor 
menu instead.) You’ll find the following preference categories available here (they’re 
discussed in detail in the appropriate parts of this book):

•	 General (or press Ctrl+K)

•	 Saving Files 

•	 Performance (where you set the number of history states and assign scratch 
disks—see page 598)

•	 Display & Cursors 

•	 Transparency 

•	 Units & Rulers 

•	 Guides & Grid 

•	 Plug-Ins

•	 Adobe Partner Services 

•	 Application Updates (where you can choose whether to have Elements update 
itself automatically or just let you know when an update is available)

•	 Type 

•	 Organize & Share (brings up the Organizer’s preferences)

Image Menu
This menu lets you make changes to an image by doing things like rotating it, chang-
ing its shape, cropping or resizing it, or changing its color mode.

ROTATE
Use these commands to change an image’s orientation (page 82). The first group 
of options applies to your whole image:

•	 90° Left 

•	 90° Right 

•	 180° 

•	 Custom 

•	 Flip Horizontal 

•	 Flip Vertical 
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IMAGE MENU
The next group does the same thing but to a layer or selection. (The wording of these 
menu items changes depending on whether you have an active selection in your 
image; if you have a selection, you’ll see the word “Selection” instead of “Layer.”)

•	 Free Rotate Layer 

•	 Rotate Layer 90° Left 

•	 Rotate Layer 90° Right 

•	 Rotate Layer 180° 

•	 Flip Layer Horizontal 

•	 Flip Layer Vertical 

Finally you can choose to:

•	 Straighten and Crop Image 

•	 Straighten Image 

These last two commands are mostly for when you need to straighten whole 
scanned images. To straighten the contents of an image, use the Straighten tool 
instead (page 84).

TRANSFORM
These commands let you change the shape of an image by pulling it in different 
directions (they’re explained in detail on page 387). Your choices are:

•	 Free Transform (Ctrl+T/z-T) incorporates the other three commands in this list.

•	 Skew slants an image.

•	 Distort stretches the photo in the direction you pull it.

•	 Perspective stretches the photo to make it look like parts are nearer or farther 
away.

 TIP  To transform images to correct perspective, you might prefer to start with the Correct Camera Distortion 
filter; see page 382.

CROP
Choose this menu item to crop an image to the area you’ve selected (page 89).

RECOMPOSE
Use this option to bring up the handy Recompose tool (page 326), which lets you 
reshape photos without distorting them and eliminate unwanted objects in them at 
the same time. You can also click its icon in the Tools panel.
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ENHANCE 
MENU

DIVIDE SCANNED PHOTOS
If you scan several photos at once and then choose this command, Elements cuts 
the photos apart and straightens and crops each one. See page 79 for more about 
how this works.

RESIZE
Here’s where you change the actual size of your image (as opposed to changing the 
size of the view on your screen). Your choices are:

•	 Image Size (page 105). Keyboard shortcut: Alt+Ctrl+I/Option-z-I.

•	 Canvas Size (page 112). Keyboard shortcut: Alt+Ctrl+C/Option-z-C.

•	 Scale (page 390).

•	 Reveal All. If you’ve been manipulating an image in ways that make parts of 
it extend past the canvas (like corners when you rotate it, for example), this 
command resizes the canvas to show the entire image.

Resizing is explained in detail in Chapter 3.

MODE
This is where you can change an image’s color mode (see page 41). Your choices are:

•	 Bitmap 

•	 Grayscale 

•	 Indexed Color 

•	 RGB Color 

You’ll also find two commands in this menu:

•	 8-bits/Channel reduces images from 16-bit color to 8-bit (see page 288).

•	 Color Table shows you the color table (the colors of your image as swatches) 
for an Indexed Color image.

CONVERT COLOR PROFILE
If you need to change the ICC (International Color Consortium) profile of an image, 
you can do it from this menu item, which lets you apply an sRGB or Adobe RGB profile, 
or remove the profile from an image. For more about color profiles, flip to page 242.

Enhance Menu
This menu contains commands you use to adjust an image’s color and lighting. The 
first six options (the ones with “Auto” in their names) apply changes automatically, 
and the remainder let you tweak the changes.
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ENHANCE 
MENU

AUTO SMART TONE
This is Adobe’s newest one-step fix for exposure and brightness. The keystroke 
shortcut is Alt+Ctrl+T/Option-z-T. It’s explained on page 142.

AUTO SMART FIX
Choose this option or press Alt+Ctrl+M/Option-z-M to have Elements adjust your 
image’s lighting, color, and contrast all at the same time (page128).

AUTO LEVELS
Use this command or press Shift+Ctrl+L/Shift-z-L to make Elements adjust your 
image’s individual color channels (page 130).

AUTO CONTRAST
Choose this command or press Alt+Shift+Ctrl+L/Option-Shift-z-L, and Elements 
adjusts the brightness and darkness of your image without changing the colors 
(page 131).

AUTO COLOR CORRECTION
Choose this option or press Shift+Ctrl+B/Shift-z-B to have Elements adjust your 
image’s color in much the same way that Levels does. Auto Color Correction looks 
at different information in your photo to make its decisions, though (page 133).

AUTO SHARPEN
This command applies the same one-click sharpening you get when you use the 
Auto Sharpen button in Quick Fix (page 134).

AUTO RED EYE FIX
Choose this command or press Ctrl+R/z-R to apply the same auto red-eye correc-
tion found in the Organizer (page 125).

ADJUST SMART FIX
This command is the same as Auto Smart Fix, except you get a slider to adjust 
the degree of change that Elements makes to your photo. Keyboard shortcut: 
Ctrl+Shift+M/z-Shift-M.

ADJUST LIGHTING
Your choices for adjusting the light and dark values in your photos are:

•	 Shadows/Highlights (page 230).

•	 Brightness/Contrast (page 229).

•	 Levels. You can also press Ctrl+L/z-L to bring up the Levels dialog box (page 
243).
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ENHANCE 
MENU

ADJUST COLOR
With these settings, you can change a color, replace a color, remove a color cast, 
remove all the color from an image, or add color to a black-and-white photo. Choose 
from:

•	 Remove Color Cast (page 252).

•	 Adjust Hue/Saturation (page 335). Keyboard shortcut: Ctrl+U/z-U.

•	 Remove Color (page 352). Keyboard shortcut: Shift+Ctrl+U/Shift-z-U.

•	 Replace Color (page 341).

•	 Adjust Color Curves (page 331). The Color Curves tool lets you adjust the bright-
ness and contrast of specific tonal ranges in a photo (like highlights or midtones).

•	 Adjust Color for Skin Tone (page 139). This setting adjusts the colors in your 
image based on the skin tones of someone you select in the photo.

•	 Defringe Layer (page 171). This setting gets rid of the rim of contrasting pixels 
you may get when you remove an object from its background.

CONVERT TO BLACK AND WHITE
Choose this menu item or press Atl+Ctrl+B/Option-z-B to convert a color photo to 
a black-and-white image (page 349).

UNSHARP MASK
This is the most popular traditional method for sharpening photos (page 260).

ADJUST SHARPNESS
Choose this menu item to use Adobe’s newest sharpening tool (page 263).

PHOTOMERGE
This is where you start any of the many Photomerge projects you can do in Elements, 
from creating a panorama to combining parts of different photos.

•	 Photomerge Compose. This new features helps you to move people or objects 
from one photo to another (page 379).

•	 Photomerge Exposure. Choose this item to combine bracketed shots into one 
properly exposed photo (page 292)

•	 Photomerge Faces. Use this one to combine parts of different faces for cari-
catures and other fun effects (page 372).

•	 Photomerge Group Shot. This lets you move a person from one photo of a 
group into another photo of the same group (page 375).

•	 Photomerge Panorama. Use this option to combine photos into panoramas 
(page 368).
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LAYER MENU
•	 Photomerge Scene Cleaner. This feature lets you remove unwanted people or 

details from a photo by copying over bits of other images (page 376).

Layer Menu
Here’s where you’ll find the commands for creating and managing layers (Chapter 
6 is all about layers). This is the most dynamic menu in Elements—what you see at 
the bottom of the menu changes depending on the layers in the open image and the 
characteristics of the active layer. This is a basic rundown of the main menu options 
you’ll usually see if your open image has only a Background layer. (Sometimes you’ll 
see choices that are visible but grayed out.) The choices for merging and combining 
layers change the most as your layers change.

NEW
This is where you create new, regular layers (as opposed to Adjustment layers). 
Your options are:

•	 Layer or press Shift+Ctrl+N/Shift-z-N.

•	 Layer from Background. If your image doesn’t currently have a Background 
layer, this item is named “Background from Layer” instead.

•	 Layer via Copy (page 194) or press Ctrl+J/z-J.

•	 Layer via Cut (page 194) or press Shift+Ctrl+J/Shift-z-J.

DUPLICATE LAYER
Use this command to make a copy of the active layer. As long as you don’t have a 
selection, you can also use Ctrl+J/z-J to do the same thing.

DELETE LAYER
To eliminate a layer, click it in the Layers panel to make it the active layer, and then 
choose this command.

RENAME LAYER
Choose this option to—you guessed it—change a layer’s name. You can also double-
click the layer’s name in the Layers panel to rename it.

LAYER STYLE
If a layer has a Layer style applied to it (page 461), you can adjust it here:

•	 Style Settings brings up the dialog box where you can adjust some of the Layer 
style’s settings. (Double-clicking the Layer style icon in the Layers panel—the 
little “fx” to the right of the layer’s name—brings up the same dialog box.)

•	 Copy Layer Style lets you copy to the Clipboard any styles applied to a layer, 
so you can apply them to another image or layer.
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LAYER MENU
•	 Paste Layer Style applies the copied style to a new layer, even in a new image.

•	 Clear Layer Style removes all the styles applied to a layer.

•	 Hide All Effects hides all the styles applied to a layer so you can see what your 
image looks like without them. (If you hide all the styles, this menu item changes 
to read “Show All Effects” instead.)

•	 Scale Effects lets you adjust the size of certain aspects of Layer styles.

NEW FILL LAYER
Choose this option to create a layer that’s filled with a color, gradient, or pattern as 
explained on page 216. (You can also do this from the Layers panel by clicking the 
Create Adjustment Layer icon [the half-blue, half-white circle]). 

NEW ADJUSTMENT LAYER
This command, not surprisingly, creates a new Adjustment layer (page 215). The 
types of layers you can create here are:

•	 Levels (page 243)

•	 Brightness/Contrast (page 229)

•	 Hue/Saturation (page 335)

•	 Gradient Map (page 475)

•	 Photo Filter (page 299)

•	 Invert (page 347)

•	 Threshold (page 347)

•	 Posterize (page 347)

LAYER CONTENT OPTIONS
If you have an Adjustment or Fill layer selected, choosing this menu item brings up 
a dialog box where you can adjust the active layer’s settings. 

TYPE
This command gives you ways to modify a Text layer, as long as you haven’t simpli-
fied the layer (page 487). You can choose:

•	 Horizontal. Change vertical text to horizontal text.

•	 Vertical. Change horizontal text to vertical text.

•	 Anti-Alias Off. Anti-aliasing is explained on page 487.

•	 Anti-Alias On.

•	 Warp Text. See page 488.

•	 Update All Text Layers.
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LAYER MENU
•	 Replace All Missing Fonts. If your image is missing fonts, this command replaces 

them, but you can’t choose which font Elements uses as the replacement. It’s 
usually just as easy to replace fonts by highlighting the text and then selecting 
a new font in the Tool Options area.

SIMPLIFY LAYER
This command rasterizes your layer, turning the layer’s contents from a vector or 
Smart Object to one that’s built pixel by pixel. See page 424 for more about the 
difference between vectors and pixels.

LAYER MASK
Elements lets you create layer masks, which you can use to hide part of a layer’s 
content (page 210). You can create a mask from the Layers panel, or you can create 
and manage masks from this menu item. Your choices here are:

•	 Reveal All. Creates a new layer mask that starts out empty (you can see the 
entire contents of the layer).

•	 Hide All. Creates a new mask that hides everything on the layer so that you can 
reveal just the parts you want to show.

•	 Reveal Selection. If you have an active selection (see Chapter 5), this command 
creates a new mask that hides everything except the selected area.

•	 Hide Selection. If you have an active selection, this creates a new mask that 
shows everything except the selected area.

•	 Delete. Gets rid of an existing layer mask.

•	 Apply. If you have a layer mask and you want to permanently reduce the layer 
to only the area that’s currently visible, choose this command. (Doing so is usu-
ally a bad idea, though, since once you run this command and close the image, 
there’s no going back.)

•	 Disable. If you want to see your image without the mask, this command turns 
it off. (If you’ve disabled the mask, the menu item reads “Enable” instead.)

•	 Unlink. If you want to be able to slide the mask around (for better framing of 
your subject, for instance), choose this item or click the little chain icon in the 
Layers panel.

CREATE CLIPPING MASK, RELEASE CLIPPING MASK
This command (described on page 206) links two layers together so the bottom one 
determines the opacity of the top one. (If you’ve used early versions of Elements, 
this is the same as the old “Group with Previous” command.) When you have clipped 
layers, this item changes to read “Release Clipping Mask” instead. Keyboard shortcut 
for either command: Ctrl+G/z-G.
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ARRANGE

Use these commands to change the order of layers in the layers stack, or just drag 
them in the Layers panel. See page 200 for details on rearranging layers. (“Front” 
is the top of the stack, and “Back” is directly above the Background layer.) Your 
options are:

•	 Bring to Front (or press Shift+Ctrl+]/Shift-z-]).

•	 Bring Forward (or press Ctrl+]/z-]).

•	 Send Backward (or press Ctrl+[/z-[).

•	 Send to Back (or press Shift+Ctrl+[/Shift-z-[).

•	 Reverse. Select two or more layers, and then choose this command to reverse 
their order in the layer stack.

MERGE LAYERS
Choose this command or press Ctrl+E/z-E to combine multiple layers into one. You 
may also see Merge Down listed here, which merges a layer with the layer immediately 
beneath it, or Merge Clipping Mask, which merges grouped layers.

MERGE VISIBLE
Use this option or press Shift+Ctrl+E/Shift-z-E to merge all the visible layers into 
one layer.

FLATTEN IMAGE
This command merges all the layers in your file into one Background layer.

Select Menu
Here’s where you make, modify, and save selections. (See Chapter 5 for more about 
selections.)

ALL
Choose this command or press Ctrl+A/z-A to select your whole image.

DESELECT
Use this command or press Ctrl+D/z-D to remove all selections from your image.

RESELECT
If you use the Deselect command but then want your selection back again, choose 
this menu item or press Shift+Ctrl+D/Shift-z-D.
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SELECT MENU
INVERSE

This command switches the selected and unselected areas of your image so that the 
area that wasn’t previously selected is now selected, and the previously selected 
area is now unselected. Keyboard shortcut: Shift+Ctrl+I/Shift-z-I.

ALL LAYERS
Use this command to select all the layers in your image, including hidden ones.

DESELECT LAYERS
Choose this option to unselect all the layers in your image.

SIMILAR LAYERS
Use this command to select all the layers of your image that are the same type, such 
as all Adjustment layers or all Text layers.

FEATHER
Choose this option or press Alt+Ctrl+D/Option-z-F to feather (blur) the edges of 
a selection (page 152).

REFINE EDGE
This command lets you groom the edges of a selection (page 156).

MODIFY
These commands let you change the size or edges of your selection:

•	 Border selects the edge of your selection (page 176).

•	 Smooth evens out ragged selections (page 176).

•	 Expand moves the edge of your selection outward (page 175).

•	 Contract moves the edge of your selection inward (page 175).

GROW
This command expands your selection to include contiguous areas of similar color 
(page 175).

SIMILAR
This option expands your selection to include more areas of similar color, but—unlike 
the Grow command—it doesn’t restrict the growth to contiguous areas (page 175).

TRANSFORM SELECTION
This command lets you adjust the size of a selection by dragging its edges (page 
169). You can also reshape it with any of the Transform commands (page 173).

LOAD SELECTION
If you’ve saved a selection, choose this command to use it again.
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SAVE SELECTION

To save a selection so you can use it later without recreating it, select this command 
(page 183).

DELETE SELECTION
Use this command to permanently remove a saved selection.

Filter Menu
Filters let you change the appearance of your image in all sorts of ways, as Chapter 
13 explains in detail. Elements comes with some filters that are mostly for cor-
recting and improving your photos, and some that create artistic effects. You can 
apply filters from this menu or from the Effects panel. The filters are grouped into 
categories to make them easier to find. Every image responds to filters differently, 
so the descriptions here are only a very rough guide.

LAST FILTER
The top item in the Filter menu always features the last filter you applied. Choose 
this item or press Ctrl+F/z-F to reapply that filter with the same settings you used 
previously. 

FILTER GALLERY
This option lets you try the effects of different filters, rearrange them, and preview 
what they’ll look like in your photo (page 437).

CORRECT CAMERA DISTORTION
Use this filter to correct various kinds of lens distortion (page 382).

ADJUSTMENTS
This group of filters is primarily (but not exclusively) for correcting and enhancing 
photos. These filters are discussed on page 346 unless otherwise noted:

•	 Equalize 

•	 Gradient Map (page 475)

•	 Invert (or press Ctrl+I/z-I)

•	 Posterize 

•	 Threshold 

•	 Photo Filter (page 299)

ARTISTIC
Use these filters to apply various artistic effects to images, ranging from a pencil-
sketch look to a watercolor effect:
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•	 Colored Pencil makes your photo look like it was sketched with a colored pencil 

on a solid-colored background.

•	 Cutout makes an image look like it was cut from pieces of paper.

•	 Dry Brush makes a photo look like it was painted using a dry brush.

•	 Film Grain adds grain to make a photo resemble old film.

•	 Fresco makes a photo look like it was painted quickly in a dabbing style.

•	 Neon Glow adds vivid color to images while softening their details.

•	 Paint Daubs gives photos a painted look.

•	 Palette Knife makes a photo look like you painted it with a palette knife. While 
you may think of a palette knife as a tool for blending heavy paint daubs, Adobe 
describes the effect of this filter as looking like a thin layer of paint that reveals 
the canvas beneath it.

•	 Plastic Wrap makes an image look like it’s covered in plastic.

•	 Poster Edges gives an image accented, dark edges while reducing the number 
of colors in the rest of the photo.

•	 Rough Pastels makes an image look like it was quickly sketched with pastels.

•	 Smudge Stick uses short, diagonal strokes that soften the image by smearing 
the detail.

•	 Sponge paints with highly textured areas of contrasting color like you’d get by 
sponging on color.

•	 Underpainting makes an image look like it’s painted on a textured background.

•	 Watercolor simplifies the details in an image so they look the way they would 
if you were creating a watercolor painting.

BLUR
You can soften and blur images with these filters:

•	 Average (page 452)

•	 Blur

•	 Blur More

•	 Gaussian Blur (page 446)

•	 Lens Blur gives a photo where the entire contents are in sharp focus a gradu-
ated background blur (bokeh) like you’d get from using a DSLR camera (see 
page 447).

•	 You apply Motion Blur pretty much the same way as Radial Blur, described 
on page 450, but it creates a one-way blur, like you’d see behind Road Runner 
when he’s scooting away from Wile E. Coyote.
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•	 Radial Blur (page 450)

•	 Smart Blur reduces grain and noise without affecting the edge sharpness of 
your photo. It’s also used for special artistic effects.

•	 Surface Blur blurs without reducing edge contrast (page 453).

BRUSH STROKES
These filters give your image a hand-painted look:

•	 Accented Edges emphasizes the edges of objects as though they were drawn 
in black ink or white chalk.

•	 Angled Strokes creates diagonal brushstrokes that all run in the same direction.

•	 Crosshatch creates diagonal brushstrokes that crisscross.

•	 Dark Strokes paints dark areas of the image with short, tight, dark strokes, and 
paints light areas with long, white strokes.

•	 Ink Outlines makes the image look like it was drawn with fine ink lines.

•	 Spatter gives the effect you’d get from a spatter airbrush.

•	 Sprayed Strokes paints the image with diagonal, sprayed strokes in its domi-
nant colors.

•	 Sumi-e gives the effect of drawing with a wet brush full of black ink, in a 
Japanese-influenced style.

DISTORT
These filters warp your image in a variety of ways:

•	 Diffuse Glow makes the image look as though you’re viewing it through a soft 
diffusion filter.

•	 Displace lets you create a map to tell Elements how to distort the image.

•	 Glass makes the image look like you’re viewing it through various kinds of glass, 
depending on the settings you choose.

•	 Liquify is described on page 493.

•	 Ocean Ripple gives an underwater effect by adding ripples to the image.

•	 Pinch pulls the edges of the photo toward the center.

•	 Polar Coordinates lets you create what’s called a cylinder anamorphosis. With 
this kind of distortion, the image would look normal if you viewed its reflection 
it in a mirrored cylinder. It’s good for projects like creating rainbow effects.

•	 Ripple creates a pattern like ripples on the surface of water. While the Ocean 
Ripple filter makes it look like you’re viewing a regular object through a distort-
ing medium like water, this filter makes the objects themselves ripple.
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•	 Shear distorts the image along a curve.

•	 Spherize makes the image expand out like a balloon.

•	 Twirl spins the photo, rotating a selection more in the center than at the edge, 
producing a twirled pattern.

•	 Wave creates a rippled pattern but with more control than the Ripple filter 
gives you.

•	 ZigZag creates a bent, zigzagging effect that’s strongest in the center of the 
area you apply this filter to.

NOISE
Use these filters to add noise (graininess) to photos or to remove noise from them 
(unless otherwise specified, these filters are explained on page 318):

•	 Add Noise (page 443)

•	 Despeckle 

•	 Dust & Scratches 

•	 Median 

•	 Reduce Noise (page 442)

PIXELATE
These filters break up your photo into spots or blocks of various kinds:

•	 Color Halftone adds the kind of dotted pattern you see in things that have been 
color-printed by a commercial press. It’s important to understand that running 
this filter isn’t the same as making true halftone for commercial printing; it just 
creates a similar look.

•	 Crystallize breaks the image into polygonal blocks of color.

•	 Facet reduces the image to blocks of solid color.

•	 Fragment makes the image look blurry and offset.

•	 Mezzotint creates an effect something like that of a mezzotint engraving.

•	 Mosaic breaks the image down to square blocks of color.

•	 Pointillize makes the photo look like it’s made of many dots of color.

RENDER
This is a diverse but powerful group of filters that transform your photos in many 
ways:

•	 Clouds covers the image with clouds made up of your Foreground and Back-
ground colors.
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•	 Difference Clouds also creates clouds, but blends them in the image in Dif-

ference mode.

•	 Fibers creates an effect like spun and woven fibers.

•	 Lens Flare creates starry bright spots like you’d get from a camera lens flare.

SKETCH
Here’s another group of artistic filters. Most of them make your image look like it 
was drawn with a pencil or graphics pen:

•	 Bas Relief gives the photo a slightly raised appearance, as though it’s carved 
in low relief.

•	 Chalk & Charcoal makes the photo look like it was sketched with a combination 
of chalk and charcoal.

•	 Charcoal gives a smudgy effect to the image, like a charcoal drawing.

•	 Chrome is supposed to make an image look like polished chrome, but you might 
prefer the Wow Chrome Layer styles in the Effects panel (page 464).

•	 Comic may not be quite what you’d expect. Instead of a cartoonish look, it 
makes the image look like an illustration (see page 441).

•	 Conté Crayon makes the image look like it was drawn with Conté crayons (a 
drawing medium originally made of graphite and wax, now made from chalks, 
that’s used for making bold strokes) using your Foreground and Background 
colors.

•	 Graphic Novel is something like the Comic filter in that it also creates an il-
lustrated look. See page 441 for an example.

•	 Graphic Pen makes the details in the image look like they were drawn with a fine 
pen set to your Foreground color, on paper that matches your Background color.

•	 Halftone Pattern gives the dotted effect of a halftone screen, like you see in 
printed illustrations. The effect only looks like a halftone—this filter doesn’t 
create a true halftone that your print shop might request.

•	 Note Paper makes the image look like it’s on handmade paper. In dark areas, 
your Background color shows through in spots.

•	 Pen and Ink makes the photo look like an ink sketch.

•	 Photocopy makes the photo look like a Xerox copy.

•	 Plaster makes the image look like it was molded in wet plaster.

•	 Reticulation creates an effect you might get from film emulsion—dark areas 
clump and brighter areas appear more lightly grained.

•	 Stamp makes the image look like an impression from a rubber stamp.

•	 Torn Edges makes the photo look like it’s made from torn pieces of paper.
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•	 Water Paper makes the photo look like it was painted on wet paper, so the 

colors run together.

STYLIZE
These filters create special effects by displacing the pixels in your image or increas-
ing contrast:

•	 Diffuse makes the photo less focused by shuffling the pixels according to the 
settings you choose.

•	 Emboss makes objects in the image appear stamped or raised.

•	 Extrude creates a 3-D effect by pushing some of the pixels in the image up, 
something like toothpaste squeezed from a tube.

•	 Find Edges emphasizes the edges of the image against a white background.

•	 Glowing Edges adds a neon-like glow to the edges of objects in the photo.

•	 Solarize produces an effect like what you’d get by briefly exposing a photo print 
to light while you’re developing it. It combines a negative and a positive image.

•	 Tiles breaks the image up into individual tiles and lets you choose how much 
to offset them.

•	 Trace Contour outlines areas where there are major transitions in brightness. 
The result is supposed to be something like a contour map.

•	 Wind makes the image look windblown.

TEXTURE
These filters change the surface of your photo so it looks like it was made from 
another material:

•	 Craquelure produces a surface effect like cracked plaster.

•	 Grain adds different kinds of graininess to the photo.

•	 Mosaic Tiles is supposed to make the photo look like it’s made of tiles with 
grout between them.

•	 Patchwork reduces the image to squares filled with the image’s predominant 
colors.

•	 Stained Glass is supposed to make the photo look like it’s made of stained 
glass, but the effect is usually more like a mosaic.

•	 Texturizer makes the photo look like it’s on canvas or brick. You can also select 
a file to use as a texture.

OTHER
This is a group of fairly technical filters:

•	 Custom lets you create your own filter.
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•	 High Pass is discussed on page 267.

•	 Maximum replaces pixels’ brightness values with the highest and lowest values 
of surrounding pixels. It spreads out white areas and shrinks dark areas.

•	 Minimum does the opposite of the Maximum filter: It spreads out dark areas 
and shrinks white ones.

•	 Offset moves your selection by the number of pixels you specify.

DIGIMARC
Use this filter to check for Digimarc watermarks in photos. Digimarc is a commercial 
system that lets subscribers enter their information in a database so that anyone 
who gets one of their photos can find out who the copyright holder is by searching 
the Digimarc database.

View Menu
This menu’s commands let you choose different ways to look at your image onscreen. 
For more details on adjusting your view, see page 97.

NEW WINDOW FOR…
This command lets you create a duplicate window for your image so you can see 
it at two different magnification levels at once. The new window goes away when 
you close your image—it doesn’t create a copy of your photo.

ZOOM IN
To increase the view size, choose this menu item, press Ctrl+=/z+=, or use the Zoom 
tool (page 102).

ZOOM OUT
To reduce the view size, choose this menu item, press Ctrl+–/z-–, or use the Zoom 
tool (page 102).

FIT ON SCREEN
Use this command or press Ctrl+0/z-0 (that’s the number zero, not the letter O) to 
make your photo as large as it can be without your having to scroll to see parts of it.

ACTUAL PIXELS
Choose this option or press Ctrl+1/z-1 to see your image in the exact size it would 
appear on the Web or in other programs that can’t adjust view size like Elements can.

PRINT SIZE
Makes Elements take its best guess as to how large your image would print at its 
current resolution (page 109).
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SELECTION

When this setting is turned on, the outlines of your selections are visible. You can 
toggle this setting off and on here, or by pressing Ctrl+H/z-H.

RULERS
If you want to see rulers around the edges of your image window, toggle them 
on and off here or by pressing Shift+Ctrl+R/Shift-z-R. You can adjust the unit 
of measurement in Edit→Preferences→Units & Rulers/Photoshop Elements 
Editor→Preferences→Units & Rulers.

GRID
If you want to see a measurement and alignment grid on your photos, use this setting 
or press Ctrl+’/z+’ (the apostrophe key) to toggle it on and off. You can adjust the grid’s 
size in Edit→Preferences→Grid/Photoshop Elements Editor→Preferences→Grid.

GUIDES
Guides (page 87) help you align objects in your files. If your image has guides in it, 
toggle their visibility off and on here or by pressing Ctrl+;/z-; (the semicolon key).

SNAP TO
If you want to control Elements’ autogrid (a hidden system that determines how 
precisely you can place things when you move them in your images), use these 
commands.

•	 Guides. When you’re working with a file that includes guidelines, this setting 
lets you control whether objects you add will snap to those guidelines.

•	 Grid. When this setting is turned on, Elements automatically jumps to the nearest 
gridline. If you find it annoying that your tools and selections keep jumping away 
from you, then turn off grid snapping here; then everything stays exactly where 
you place it. (You have to make the grid visible—by going to View→Grid—before 
you can change its settings.)

•	 Layers. Choose this option and whatever you move will automatically align with 
the contents of the layer below the active layer.

•	 Document Bounds. Choose this setting and, when you’re working near the 
edge of an image, your selection will automatically expand to include the edges 
of the photo. 

LOCK GUIDES
If you’ve created guides (page 87) in your image and you don’t want them to move, 
use this menu item or press Alt+Ctrl+;/Option-z-; (the semicolon key) to fix them 
in place.

CLEAR GUIDES
If you have guides (page 87) in your image and you want to get rid of them, choose 
this menu item.
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NEW GUIDE

To create a nonprinting guideline (page 87) in your image so that you can easily 
align objects, select this menu item.

Window Menu
This menu controls which panels and bins you see, and lets you adjust how Ele-
ments displays your image tabs or windows. (Windows that are currently visible 
have checkmarks next to their names in this menu.)

IMAGES
Use these commands to control how Elements displays your images (your choices 
are explained in detail on page 99):

•	 Tile. The images appear edge to edge so that all the windows or tabs are 
equally visible.

•	 Cascade. The image windows appear in overlapping stacks. (You can’t choose 
this menu item when using tabs.)

•	 Float in Window. Choose this command to make the active image tab into a floating 
window. (You first have to turn on floating windows in Edit→Preferences→General/
Photoshop Elements Editor→Preferences→General.)

•	 Float All in Windows. If you’ve turned on floating windows, choose this com-
mand to turn all your image tabs into windows.

•	 Consolidate All to Tabs. If you have floating windows and you want to go back 
to tabbed view, select this item.

•	 New Window. This is the same as the View menu’s “New Window for…” com-
mand. It opens a separate view of your image, not a duplicate file.

•	 Minimize (Mac only). If you have tabs, choosing this item or pressing z-M 
sends the entire Elements window to the Dock. If you have floating windows, 
it minimizes only the image window.

•	 Bring All to Front (Mac only). Choose this command to bring all your open 
Elements images front and center.

•	 Match Zoom. Choose this item to get the same magnification level in all open 
windows as in the active image window.

•	 Match Location. When you have only part of a photo visible in a window, choose 
this command to make all open windows display the same part of their images, 
like the upper-left corner, for example.

TOOLS
Select this menu item to hide or show the Tools panel (page 18).
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ACTIONS

This is where you call up the Actions panel (page 454).

ADJUSTMENTS
This option shows and hides the Adjustments panel (page 218).

COLOR SWATCHES
Select this item to show or hide the Color Swatches panel (page 258).

EFFECTS
This menu item shows and hides the Effects panel, from which you apply filters, 
photo effects, and Layer styles.

FAVORITES
You can put your favorite items from the Graphics and Effects panels into the Fa-
vorites panel for easier access (page 527). 

GRAPHICS
The Graphics panel holds frames, backgrounds, graphics, shapes, and text effects 
to use in projects. See page 526 for more about this panel.

HISTOGRAM
Select this item to show or hide the Histogram in its own panel (page 245).

HISTORY
This item setting displays or hides the History panel. This panel shows a record of 
all the changes to your image up to the number of states you set in Edit→Preferen
ces→Performance→History States/Photoshop Elements Editor→Preferences→Pe
rformance→History States. Page 25 has more about this panel.

INFO
Select this option to bring up a panel with information about your photos, like their 
file sizes and color values.

LAYERS
Show or hide the Layers panel by choosing this item. See page187 for more info.

NAVIGATOR
Turn the Navigator (page 104) off and on here. The Navigator lets you control which 
portion of a large image is visible onscreen and adjust the zoom level.

PANEL BIN
This setting minimizes (hides) and maximizes (reopens) the Panel Bin (page 14). You 
can also just click the edge of the bin to hide or expand it.
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RESET PANELS

Use this command to return all your panels to their original locations. 

IMAGE WINDOWS/TABS
At the bottom of the Window menu, you see a list of all the files you have open in 
Elements. Choose one to bring it to the front as the active window or tab.

Help Menu
The menu is where you find Elements’ Help files and information about the program.

SEARCH BOX (MAC ONLY)
You can type a term into this box to search the program’s menus, not the Elements 
Help Files. 

PHOTOSHOP ELEMENTS HELP
When you select this menu item or press F1/z-?, Adobe Community Help launches 
to show you Adobe’s Help files. (This is online content, viewed in your web browser.)

GETTING STARTED
This menu item takes you to a section of Adobe’s website that includes video tutori-
als to help newbies.

KEY CONCEPTS
Elements’ Help files include a glossary of digital-imaging terms. If you’re wondering 
what a particular term means, choose this menu item and it’ll take you to the online 
glossary so you can look it up.

SUPPORT
Select this option to go to Adobe’s online Support website and knowledgebase.

VIDEO TUTORIALS
Choose this menu item to go to the video tutorials section of Adobe’s support 
website, where you can watch videos on how to perform popular Elements tasks.

FORUM
This takes you to Adobe’s online support forum for Photoshop Elements.

WELCOME SCREEN
Choose this menu item to see the Welcome screen that appears in Windows when 
Elements starts up.
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ABOUT PHOTOSHOP ELEMENTS (WINDOWS ONLY)

Choose this item to see a scrolling window with info about the version of Elements 
you’ve got. You’ll also see a very long list of patents and credits—a testament to the 
complexity of Elements’ engineering. (On a Mac, you’ll find this and the next two 
items in this list in the Photoshop Elements Editor menu instead.)

ABOUT PLUG-IN (WINDOWS ONLY)
Select this option to display a long pop-out menu that lists all the plug-ins in your 
copy of Elements. Choose a plug-in from the list to see its version number and date 
information.

LEGAL NOTICES (WINDOWS ONLY)
This menu item displays a long list of the various patents for Elements, as well as 
trademark info for some of the components used in the program.

SYSTEM INFO
Choose this item to see a window with information about Elements and your op-
erating system. If you can’t remember which Windows service pack you have, for 
instance, you can find out here. 

MANAGE MY ACCOUNT
This is where you can change the password for your Adobe ID and turn off or turn 
on allowing your computer to share information with Adobe about how you use 
Elements. 

SIGN OUT (YOUR NAME)
In Elements 13, you have to stay signed in to use the program. If you sign out, you 
deactivate Elements on that particular computer. So only sign out when you’re sure 
you don’t need to use it on that machine anymore. 

UPDATES
This is where you check for updates to Elements components. 


